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Introduction 

 

Video Insight is a leading developer of enterprise-class video management software. Our vision is to 

provide powerful, user-friendly software that will run on "off-the-shelf" hardware based on IP 

technology. We have developed our solution from the ground-up, making us one of the few pure-play IP 

video management software providers. 

±ƛŘŜƻ LƴǎƛƎƘǘΩǎ ǎǳƛǘŜ ƻŦ ǇǊƻŘǳŎǘǎ ǿŀǎ ŎǊŜŀǘŜŘ ǘƻ ǇǊƻǘŜŎǘ ŎƭƛŜƴǘǎ ōȅ ǇǊƻǾƛŘƛƴƎ ƛƴǘelligent, easy to use IP 

security solutions. Our extensive effort has resulted in products that are flexible and powerful enough 

for any situation, yet still very cost effective. Our software boasts the largest number of camera 

integrations available on the market. Users can access their Video Insight surveillance systems on mobile 

devices, through the web and on Microsoft Windows clients over internal networks or the Internet. 

Video Insight v5.5 can intelligently and efficiently monitor security throughout your organization. Key 

advantages of this version are: 

¶ Pure 64-bit server, clients and camera drivers 

¶ Cloud-ready 

¶ Optimized for centralization and hosting 

¶ Panic button features 

¶ Refresh Live Display only on Motion 

The Video Insight IP Server Administrator Guide includes everything you need to install and configure IP 

Server with best practices and a troubleshooting guide. This document is intended for use by advanced 

users and system administrators. 
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System Overview 
The Video Insight application suite provides a solution for many different scenarios. You can use it for 

basic unattended monitoring or mobile remote viewing by patrolling security personnel.  At its core is 

Video Insight IP Server, which powers the software platform. The figure below shows video monitoring 

options for users. 

 

The Video Insight application suite runs over an Ethernet network, meaning cameras, security personnel 

and servers do not have to be co-located. 

  



Video Insight Administrator Guide   IP Server v5.5 

 

 
Page 9 | Video Insight © 2014 

 

The figure below shows the distributed flexibility of the system extending ǘƻ Lt {ŜǊǾŜǊΩǎ ŀǳǘƻƳŀǘƛŎ 

failover capability. 
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The system is a robust software platform that has three main components that capture and view live or 

recorded video from anywhere: IP Server, Monitor Station and Web Client. The table below summarizes 

the role of hardware in the Video Insight application suite. 
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Table 1:  Role of Client Applications, Hardware, and Software in the Video Insight application suite. 

 

Product Suite: IP Server 

C
lie

n
t 
A

p
p

lic
a

tio
n
s 

Monitor Station 

Á Client application 

Á Live and recorded video 

Á Centralized administration 

Á Alarm notification 

Web Client 

Á Live and recorded video 

Á Internet Explorer, Safari, Chrome and 

Opera (with optional ActiveX plug-in 

support for Internet Explorer) 

Smart 

Phone/Tablet 

Client 

Á Live and recorded video 

Á iPhone, iPad, BlackBerry and Android 

support 

Á PTZ control 

 

H
a

rd
w

a
re

 

IP Server 

Á Records and manages video 

Á VM support 

Á Alarm processing 

Á 3rd-party, access control and analytics 

integration 

Á Microsoft IIS for Internet clients 

Á Active Directory, LDAP and Novell 

eDirectory support 

Storage 

Á Direct Attached, SAN/NAS and iSCSI 

storage support 

 

S
o

ft
w

a
re

 

IP Server Manager 

Á Monitors the IP Server(s) and presents a 

visual status for each 

Á Network connection administration 

Á Diagnostics for trouble shooting and 
system optimization 

Health Monitor 

Á Accessory application that monitors the 

health of all your servers and cameras 

from a single location 

Á Email notification on error 
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Planning 
Getting the most out of your hardware and our software requires planning. Understanding your needs 

will help you size your solution. Evaluate and plan the integrations you will need to make. 

Server 

IP Server is at the heart of the Video Insight platform. It runs on industry-standard hardware and works 

with 32- and 64-bit versions of these Microsoft operating systems. 

¶ Windows Server 2008 R2 

¶ Windows Server 2008 Enterprise, Standard and Web editions 

¶ Windows Server 2003 Enterprise, Standard and Web editions 

¶ Windows 7 

¶ Windows Vista 

¶ Windows XP Professional 

IP Server also requires Microsoft .NET Framework 3.5 and Microsoft Internet Information Services (IIS) 

ǿƛǘƘ άǎǘŀǘƛŎ ŎƻƴǘŜƴǘέ ŜƴŀōƭŜŘΦ ¢ƘŜ ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳ Ƴǳǎǘ ōŜ ŎǳǊǊŜƴǘ ǿƛǘƘ ǳǇŘŀǘŜǎ ōŜŎŀǳǎŜ ±ƛŘeo 

Insight hardware and software integrates with the latest updates. 

The hardware required for installation of IP Server is determined by a variety of factors including the 

number of cameras, the resolution of those cameras, the number of frames per second, as well as the 

number of days of required video storage. Generally, hardware requirements depend on whether 100 or 

more cameras will be connected. For less than 100 cameras use Table 2 as your guide. 
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Table 2: Video Insight IP Server hardware requirements for systems with less than 100 cameras. 

Component Minimum Recommended 

Processor 1 2.4 GHz quad-core 2+ 2.4 GHz quad-core 

Memory 8 GB 16 GB 

Video X MB Xx MB 

Network X Gb/s Xx Gb/s 

Storage  RAID 5/6 

 

Keep in mind that you can expect higher CPU usage without Microsoft Direct Show installed. Also, the 

server video memory requirement depends on whether compression will be used.  

Table 3 shows the hardware requirements if you plan on connecting more than 100 cameras. 

Table 3: Video Insight IP Server hardware requirements for systems with more than 100 cameras. 

Component Minimum Recommended 

Processor 2 2.4 GHz quad-core 4+ 2.4 GHz quad-core 

Memory 16 GB 32 GB 

Video X MB Xx MB 

Network X Gb/s Xx Gb/s 

Storage  RAID 5/6 

 

Network throughput is especially important when more than 100 cameras will be connected. High 

definition cameras will slow already busy network segments to a crawl. 
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Failover Server 
In the event a network outage or hardware failure prevents a server from recording camera video, the IP 

Server Failover Server feature will enable another server to take over the recording capabilities of the 

offline server. When configured with a shared IP address as part of a cluster, the Failover Server feature 

eliminates video loss and enables continuous live streaming video. 

To use the Failover Server feature you must: 

¶ Have at least two servers with the same hardware configuration, i.e., a cluster. 

¶ Have a Shared Database installation; see IP Server installation with an existing SQL installation. 

¶ Have a shared IP address. 

¶ Have at least one license and a serial number or activation key for each server. 

Network 
Network configuration is extremely important when implementing an IP video solution. IP cameras use 

considerable bandwidth to deliver information between the camera and the server. Different cameras 

will require different amounts of bandwidth based on resolution and frame rate. Accessing video from 

Monitor Station, Web Client, mobile device client and Video Wall increases the needed bandwidth. 

Figure 3 illustrates a very basic, isolated network comprising of one switch, one camera and one router. 

Figure 3: Basic IP video monitoring solution with remote viewing. 
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Factors affecting performance 
Any system is the sum of its parts. A mismatched sub-system or component can have a negative effect 

on the whole system. Video streaming can only be as good as the cameras and underlying network. Best 

practices for IP video solutions indicate cameras connected to and powered over Ethernet or separate 

VLANs for cameras. 

Local and Wide Area Network 

Video travels over a network, meaning infrastructure plays a big part in the overall performance of the 

Video Insight solution. A slow network can create bottlenecks that result in a slow frame rate, jittery 

video and packet loss. Avoid devices on your local network with a port speed of 100 Mb/s or less. 

The following network issues can cause cameras to drop a connection or otherwise go offline: 

¶ Camera is using a dynamic instead of static IP address 

¶ Another service or device is running at the same time with the same IP address, causing a 

conflict 

¶ Multiple applications pulling a stream from one camera (some cameras limit the number of 

streams) 

¶ Power output of a switch is less than required by the cameras. The power output of a switch has 

to be greater than the sum of the power requirements of the attached cameras. Refer to the camŜǊŀΩs 

manual for power requirements 

You may be tempted to implement wireless local networking to connect cameras. Due to potential dead 

zones, transmission speed, outside interference and weather conditions you can expect subpar 

performance and dropped connections. We do not recommend using wireless networking to connect 

your cameras. 

If your organization has more than one site you will likely be relying on an Internet provider for 

connectivity. The performance you get from the provider will depend on their network infrastructure, 

customer utilization of that network and what you can afford. Streaming video remotely to a desktop 

client requires basic broadband. Streaming to a mobile device requires 4G service. 

Cameras 

The following factors can affect camera imaging: 

¶ Bit rate ς a higher bit rate usually gives better picture quality 

¶ Resolution ς a higher resolution usually gives better picture quality 

¶ Format ς some picture formats incorporate better algorithms that more accurately represent 

the subject 

¶ Firmware ς outdated firmware can impair camera functionality 

¶ Location ς unless intended for such use, placement in dark or obstructed locations, or in places 

affected by adverse weather, will not result in useful pictures 

¶ Number of cameras connected to server ς the higher the number of connected cameras, the 

greater the load on server resources 
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Monitor Station 

Monitor Station, the Video Insight thick client, allows users full access to all cameras and provides 

centralized administration for the system. It is used to watch live and recorded video. 

Monitor Station runs on industry-standard hardware and works with 32- and 64-bit versions of 

Microsoft Windows XP or later. Microsoft Direct Show 9 or higher is required. The operating system 

must be current with updates because Video Insight hardware and software integrates with the latest 

updates. 

aƻƴƛǘƻǊ {ǘŀǘƛƻƴ ǊŜǉǳŜǎǘǎ ǾƛŘŜƻ ŦǊƻƳ ǘƘŜ ǎŜǊǾŜǊ ƛƴ ǘƘŜ ŎŀƳŜǊŀΩǎ ƴŀǘƛǾŜ ŦƻǊƳŀǘ. Transferring video in the 

ŎŀƳŜǊŀΩǎ ƴŀǘƛǾŜ ŦƻǊƳŀǘ ƛǎ ŀ ŦƛƭŜ ǎŜǊǾŜǊ ƻǇeration that does not burden the IP Server CPU as a video 

decompression operation would. Because video decompression is performed on the client and not the 

server, the hardware requirements for Monitor Station are different from those of IP Server. Table 4 

shows the hardware requirements for Monitor Station. 

Table 4: Monitor Station hardware requirements. 

Component Minimum Recommended 

Processor 1 2.0 GHz single-core 1 2.4 GHz dual-core 

Memory 2 GB 4 GB 

Video 256 MB 512 MB 

Network 100 Mb/s 1 Gb/s 

 

Note 
The video sub-system must support Microsoft Direct Show.  

Monitor Station will require additional system memory, video memory and processor if more cameras 

are viewed and processor-intensive compression protocols are used. The greater the number of 

compressed images viewed at once, the greater the load on the processor. 

Web Client 

Web Client, the Video Insight thin client, allows users remote access to cameras. Web Client is distinct 

from the Video Insight mobile device application.  Web Client utilizes Microsoft IIS services hosted on 

the same server as IP Server. To support cross platform compatibility, IP Server sends MJPEG images to 

clients that are unable to decompress MPEG4 or H.264 streams. These images are normally provided as 

a dual stream from the camera. IP Server can create a MJPEG but this increases the load on the CPU. 
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Web Client connects directly to the cameras to view live video, unlike Monitor Station. Table 5 shows 

Internet browsers supported by Web Client. 

Microsoft IIS 5.1 or higher must be installed and configured prior to the installation of IP Server. 

Health Monitor 

Health Monitor is a separate application used to monitor the health of one or all of your servers. Health 

Monitor adds peace of mind with a server monitoring your video surveillance servers and cameras. You 

can further mitigate risk and disaster recovery issues by adding a Failover Server. 

Health Monitor does not have any hardware requirements and is compatible with the same operating 

systems as IP Server. However, keep the following in mind when planning for Health Monitor: 

1. We recommend hosting Health Monitor on its own computer to isolate it from the failure of an 

IP Server. 

2. Health Monitor does not have to be on the same network subnet as IP Server. It can be local or 

remote.  

3. Health Monitor requires a database. It can be local or remote. If the database will be remote 

you must create it before you install Health Monitor. 

Cameras 
Video Insight supports a vast array of cameras from a large number of manufacturers. Additional camera 

support is included with every software release Refer to our website for the latest list of supported 

cameras. 

Video Insight supports the Open Network Video Interface Forum (ONVIF) standard. We support version 

1.03. 

Licensing 
Our licensing structure is simple: one camera requires one license. Our floating licenses means there is 

no need to tie a licensing seat, IP address or MAC address to a particular camera. Cameras offering 

multiple camera views only require one license. Separate video streams from the same camera do not 

require a separate license. Video Insight offers encoders, such as the VP16, that allow up to 16 analog 

cameras with only one license. Please contact us for more information on specific licensing 

requirements. 

Note 
Some cameras include a license for use with our software.  

Router configuration 

We recommend using some type of router if your computer is connected to the internet. Small 

Office/Home Office (SOHO) routers provide a simple hardware firewall that protects your computer. 

SOHO routers connect to your DSL or cable modem and you connect to your server through them. The 
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SOHO router prevents all inbound traffic from accessing your network and computers except for the 

traffic that you specifically allow through. 

How to configure your Video Insight server and router for remote access: 
1. Assign a static IP address to IP Server. SOHO routers typically use DHCP to assign an IP address 

from a range of addresses to devices connected to the router. Choose an address outside of this range 

but within the subnet to assign to the server. For help on assigning a static IP address, review your SOHO 

router user guide or consult with your network administrator. 

2. Configure your SOHO router to forward ports 80 and 4011 to IP Server. 

a. For help on forwarding ports, review your router manual or consult with your network 

administrator. 

b. www.portfoward.com provides information on how to configure most SOHO routers. Video 

Insight does not endorse this information. 

3. Test your configuration by trying to access the Web Client externally. 

a. Start your Internet browser. 

b. Enter: http://<external IP>/videoinsight4 into the address bar of your Internet browser. 

c. Note, many SOHO routers will not allow you to connect to your external IP address when you 

are behind the firewall. You will need to be outside your network. 

d. You can use a third-party website such as canyouseeme.org to get your external IP address and 

to verify if the correct ports are being forwarded. 

Storage considerations 
The amount of storage required for recordings depends on the number of cameras, the CODEC, Frames 
per Second (FPS), resolution of the images and the percentage of pixel change. The Video Insight 
solution gives you flexibility of per camera storage options: 

¶ Record Always ς requires significantly more storage space because video is constantly recorded. 

¶ Record On Motion Only ς requires less storage space than Record Always because video is 

recorded only when motion ƻŎŎǳǊǎ ƛƴ ǘƘŜ ŎŀƳŜǊŀΩǎ ŦƛŜƭŘ ƻŦ ǾƛŜǿΦ 

IP Server supports the following types of storage: 

¶ RAID 5 and RAID 6 

¶ NAS 

¶ SAN  

¶ Long Term Storage Application (LTS) 

You can specify which cameras to copy, how many days to keep before copying and what time of the 

day to execute the copy. The copied files can be viewed using Video Insight software or Microsoft 

Windows Media Player. 

¶ File Manipulation Rule 

A feature that allows users to back up their files to other locations such as standard file servers, NAS or 

SAN using the Rules manager. This feature takes the task of remembering to back up important video 

recordings on the local server and automates it. File Manipulation can also move or delete videos. 

http://www.portfoward.com/
file:///E:/Video%20Insight%20backup/canyouseeme.org
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Database considerations 
IP Server saves configuration settings, user names, camera information and event logs in a Microsoft 

SQL database. When IP Server starts, it reads its settings directly from the assigned database. When 

Monitor Station connects to IP Server it saves all recordings to its local hard drive so recordings are still 

accessible in the case of database failure. 

Use Table 5 to help you determine whether you need a local or a shared database. 

Table 5: Choosing a local or shared database. 

Local Shared 

Small centralized organization with 1-3 servers  Large regional organizational with many servers 

Use Monitor Station and built in User Manager Use Active Directory/LDAP 

Number of users is small Number of users is large 

5ƛǎŀǎǘŜǊ ǊŜŎƻǾŜǊȅ ŀƴŘ ōŀŎƪ ǳǇ ŦƻǊ ŜŀŎƘ ǎŜǊǾŜǊΩǎ 

database 

Disaster recovery and back up for one database 

Failover server functionality is not desired Failover server functionality is desired 

Servers are not on the same LAN or the 

communication link between the server the 

database is a low-speed connection 

Servers are on the same LAN 

Cameras will not move from one server to another Cameras will move from one server to another 

Avoid exposure SQL to the network Exposure of SQL to the network 
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Software installation 

±ƛŘŜƻ LƴǎƛƎƘǘ ǎƻŦǘǿŀǊŜ ǎǳǇǇƻǊǘǎ ōƻǘƘ он- ŀƴŘ сп-ōƛǘ ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳǎΦ /ƘƻƻǎŜ ǘƘŜ ŎƻǊǊŜŎǘ ŜȄŜŎǳǘŀōƭŜ ǘƻ 
ōŜƎƛƴ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ǇǊƻŎŜǎǎΦ wŜǾƛŜǿ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ƭƛǎǘ ǇǊƛƻǊ ǘƻ ōŜƎƛƴƴƛƴƎ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ǇǊƻŎŜǎǎΥ 
 
1. Storage Considerations 
2. SQL Considerations 
3. Network Considerations 
4. Online Calculator: www.video-insight.com/Support/Tools/Configuration-Calculator.aspx 
5. Administrator-level access on server is required 
 
IP Server 
LŦ aƛŎǊƻǎƻŦǘ {v[ {ŜǊǾŜǊ ƛǎ ƴƻǘ ŀƭǊŜŀŘȅ ǇǊŜǎŜƴǘ ƛƴ ȅƻǳǊ ŜƴǾƛǊƻƴƳŜƴǘ ȅƻǳ Ŏŀƴ ŎƘƻƻǎŜ ǘƻ ƛƴǎǘŀƭƭ ǘƘŜ ǇŀŎƪŀƎŜΦ 
Lǘ ƛƴŎƭǳŘŜǎ aƛŎǊƻǎƻŦǘ {v[ {ŜǊǾŜǊ нллу wн ŦƻǊ ōƻǘƘ он-ōƛǘ ŀƴŘ сп-ōƛǘ h{ϥǎΦ 
LŦ ȅƻǳǊ ŜƴǾƛǊƻƴƳŜƴǘ ŀƭǊŜŀŘȅ Ƙŀǎ aƛŎǊƻǎƻŦǘ {v[ {ŜǊǾŜǊ нллу ƛƴǎǘŀƭƭŜŘ ŀƴŘ ȅƻǳ ƻƴƭȅ ƴŜŜŘ ǘƘŜ ±ƛŘŜƻ LƴǎƛƎƘǘ 
ŘŀǘŀōŀǎŜ ŀƴŘ ŀǊŜ ƴƻǘ ǊŜǉǳƛǊŜŘ ǘƻ ƛƴǎǘŀƭƭ {v[ {ŜǊǾŜǊ ƛƴǎǘŀƭƭŀǘƛƻƴ ǇŀŎƪŀƎŜΦ 

Installation without an existing SQL installation 

¦ǎŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǎǘŜǇǎ ǘƻ ƛƴǎǘŀƭƭ Lt {ŜǊǾŜǊ ǿƛǘƘ aƛŎǊƻǎƻŦǘ {v[ {ŜǊǾŜǊ ŦƻǊ ǘƘŜ ŦƛǊǎǘ ǘƛƳŜΦ ¢Ƙƛǎ ƻǇǘƛƻƴ ǿƛƭƭ 
ŀƭǎƻ ƛƴǎǘŀƭƭ aƻƴƛǘƻǊ {ǘŀǘƛƻƴ ŀƴŘ ²Ŝō /ƭƛŜƴǘΥ 
1. Launch the executable for your OS type (32-bit or 64-bit OS).  Click I Agree to agree to 
the terms and continue the installation. If you do not agree or do not want to continue the installation, 
click Cancel. 
 

 
 
2. Select all the components that you would like to install, click Next.  

http://video-insight.com/Support/Tools/Configuration-Calculator.aspx
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3. To accept the default destination folder, click Install. To choose another destination, enter the 
destination path or click Browse to search.  
 

 
 
4. Select the start menu folder that you would like the installation to be created, click Next. 
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5. The default credentials are entered for the SQL installation, if you would like to change the 

credentials please enter them now and click Install.       

 

 

 
6.  Lt {ŜǊǾŜǊ ƛǎ ƛƴǎǘŀƭƭŜŘΦ ¢ƻ ƛƴƛǘƛŀƭƛȊŜ ŀƴŘ ŎƻƴŦƛƎǳǊŜ ƛǘΣ ǎŜŜ LƴƛǘƛŀƭƛȊŀǘƛƻƴΦ 
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Installation with an existing SQL installation 

¦ǎŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǎǘŜǇǎ ǘƻ ƛƴǎǘŀƭƭ Lt {ŜǊǾŜǊ ŦƻǊ ǘƘŜ ŦƛǊǎǘ ǘƛƳŜ ƛƴ ŀƴ ŜƴǾƛǊƻƴƳŜƴǘ ǿƛǘƘ aƛŎǊƻǎƻŦǘ {v[ {ŜǊǾŜǊΦ 
¢Ƙƛǎ ƻǇǘƛƻƴ ǿƛƭƭ ŀƭǎƻ ƛƴǎǘŀƭƭ aƻƴƛǘƻǊ {ǘŀǘƛƻƴ ŀƴŘ ²Ŝō /ƭƛŜƴǘΦ  
 
1. [ŀǳƴŎƘ ǘƘŜ ŜȄŜŎǳǘŀōƭŜ ŦƻǊ ȅƻǳǊ h{ ǘȅǇŜ όон-ōƛǘ ƻǊ сп-ōƛǘ h{ύΦ /ƭƛŎƪ L !ƎǊŜŜ ǘƻ ŀƎǊŜŜ ǘƻ ǘƘŜ ǘŜǊƳǎ 
ŀƴŘ ŎƻƴǘƛƴǳŜ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴΦ LŦ ȅƻǳ Řƻ ƴƻǘ ŀƎǊŜŜ ƻǊ Řƻ ƴƻǘ ǿŀƴǘ ǘƻ ŎƻƴǘƛƴǳŜ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴΣ ŎƭƛŎƪ 
/ŀƴŎŜƭΦ 
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2. {ŜƭŜŎǘ ŀƭƭ ǘƘŜ ŎƻƳǇƻƴŜƴǘǎ ǘƘŀǘ ȅƻǳ ǿƻǳƭŘ ƭƛƪŜ ǘƻ ƛƴǎǘŀƭƭΣ ŎƭƛŎƪ bŜȄǘΦ  
 

 

3. ¢ƻ ŀŎŎŜǇǘ ǘƘŜ ŘŜŦŀǳƭǘ ŘŜǎǘƛƴŀǘƛƻƴ ŦƻƭŘŜǊΣ ŎƭƛŎƪ LƴǎǘŀƭƭΦ ¢ƻ ŎƘƻƻǎŜ ŀƴƻǘƘŜǊ ŘŜǎǘƛƴŀǘƛƻƴ ŜƴǘŜǊ ǘƘŜ 
ŘŜǎǘƛƴŀǘƛƻƴ ǇŀǘƘ ƻǊ ŎƭƛŎƪ .ǊƻǿǎŜΦ /ƭƛŎƪ bŜȄǘ ǘƻ ōŜƎƛƴ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ǇǊƻŎŜǎǎΦ  
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4. {ŜƭŜŎǘ ǘƘŜ ǎǘŀǊǘ ƳŜƴǳ ŦƻƭŘŜǊ ǘƘŀǘ ȅƻǳ ǿƻǳƭŘ ƭƛƪŜ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ǘƻ ōŜ ŎǊŜŀǘŜŘΣ ŎƭƛŎƪ bŜȄǘΦ 
 

 
 
5. ¢ƘŜ ŘŜŦŀǳƭǘ ŎǊŜŘŜƴǘƛŀƭǎ ŀǊŜ ŜƴǘŜǊŜŘ ŦƻǊ ǘƘŜ {v[ ƛƴǎǘŀƭƭŀǘƛƻƴΦ LŦ ȅƻǳ ǿƻǳƭŘ ƭƛƪŜ ǘƻ ŎƘŀƴƎŜ ǘƘŜ 
ŎǊŜŘŜƴǘƛŀƭǎΣ ǇƭŜŀǎŜ ŜƴǘŜǊ ǘƘŜƳ ƴƻǿ ŀƴŘ ŎƭƛŎƪ LƴǎǘŀƭƭΦ 
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6.  Lt {ŜǊǾŜǊ ƛǎ ƛƴǎǘŀƭƭŜŘΦ ¢ƻ ƛƴƛǘƛŀƭƛȊŜ ŀƴŘ ŎƻƴŦƛƎǳǊŜ ƛǘΣ ǎŜŜ LƴƛǘƛŀƭƛȊŀǘƛƻƴΦ 

Initialization 

¸ƻǳ Ƴǳǎǘ ŀŎǘƛǾŀǘŜ ŀƴŘ ƛƴƛǘƛŀƭƛȊŜ Lt {ŜǊǾŜǊ ōŜŦƻǊŜ ȅƻǳ Ŏŀƴ ǳǎŜ ƛǘΦ 
 
¢ƻ ŀŎǘƛǾŀǘŜ Lt {ŜǊǾŜǊ ǿƛǘƘ ŀ ǎŜǊƛŀƭ ƴǳƳōŜǊΥ 

 
1. If you are activating IP Server with a serial number, click Next. If you are activating by phone, 
click Next and go to page 34. If you are activating a demo, click Next and go to page 35. 
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2. Enter the five character alpha-numeric serial number provided to you at the time of purchase 

and then click Next. 

Clicking Cancel will abort the installation and the server will not start automatically. 

Note 
Select Activate by Phone and call 713-621-
9779 if you are having a problem activating 
the software with your serial number, or 
select Demo mode to start recording 
immediately.  

Toll charges may apply. 
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4. Enter your user information if you would like to be notified of updates and releases, and then 
click Next.  
 
If you would like to enter this information later, select Register Later and then click Next.  
 

 
 

IP Server automatically detects most settings for you. Verify the information or make changes, then click 
Next. 
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Note 
Recording to a shared location requires a user with write 
permission to that share or recordings will not be saved. 

{ŜǊǾŜǊ bŀƳŜΥ ¢ƘŜ ŘŜŦŀǳƭǘ ƛǎ άLt {ŜǊǾŜǊ ςάŀƴŘ ǘƘŜ ŘŜǘŜŎǘŜŘ Lt ŀŘŘǊŜǎǎ ƻŦ ǘƘƛǎ ǎŜǊǾŜǊΦ ¸ƻǳ Ŏŀƴ ŎƘŀƴƎŜ ǘƘƛǎ 
ǘƻ ŀ ƳƻǊŜ ŦǊƛŜƴŘƭȅ ƻǊ ƳŜŀƴƛƴƎŦǳƭ ƴŀƳŜΦ 5ƻ ƴƻǘ ǳǎŜ ǎǇŜŎƛŀƭ ŎƘŀǊŀŎǘŜǊǎΦ 
 
Lt !ŘŘǊŜǎǎΥ ¢Ƙƛǎ ƛǎ ǘƘŜ ǎŜƭŜŎǘŜŘ ǎŜǊǾŜǊΩǎ Lt ŀŘŘǊŜǎǎ ŀƴŘ ǎƘƻǳƭŘ ƴƻǘ ōŜ ŎƘŀƴƎŜŘΦ 
 
±ŜǊǎƛƻƴΥ ¢ƘŜ ŎǳǊǊŜƴǘ ǾŜǊǎƛƻƴ ƻŦ ǘƘŜ ǎƻŦǘǿŀǊŜΦ 
 
CƻǊ ŀŘŘƛǘƛƻƴŀƭ ǎŜǘǘƛƴƎǎ ŎƭƛŎƪ !ŘǾŀƴŎŜŘΦ ¢ƘŜ 5ŜŦŀǳƭǘ tƻǊǘ ƛǎ плмл ŀƴŘ ǘƘŜ /ƻƳƳŀƴŘ tƻǊǘ ƛǎ плммΦ 5ƻ ƴƻǘ 
ŎƘŀƴƎŜ ǘƘŜǎŜ ǾŀƭǳŜǎ ǳƴƭŜǎǎ ǘƘŜ ǇƻǊǘǎ ŀǊŜ ŀƭǊŜŀŘȅ ƛƴ ǳǎŜ ōȅ ŀƴƻǘƘŜǊ ǇǊƻƎǊŀƳΦ 
 
{v[ {ŜǊǾŜǊ [ƻŎŀǘƛƻƴΥ ¢Ƙƛǎ ƛǎ ǘƘŜ ƭƻŎŀǘƛƻƴ ƻǊ Lt ŀŘŘǊŜǎǎ ƻŦ ǘƘŜ ŘŀǘŀōŀǎŜ ǎŜǊǾŜǊΦ Ψ[ƻŎŀƭƘƻǎǘΩ ƛƴŘƛŎŀǘŜǎ ǘƘŀǘ 
ǘƘŜ ŘŀǘŀōŀǎŜ ŀƴŘ aƛŎǊƻǎƻŦǘ {v[ ǎŜǊǾŜǊ ŀǊŜ ƭƻŎŀƭ ǘƻ ǘƘŜ Ƙƻǎǘ ŎƻƳǇǳǘŜǊΦ !ƴ Lt ŀŘŘǊŜǎǎ ƛƴ ǘƘƛǎ ŦƛŜƭŘ 
ƛƴŘƛŎŀǘŜǎ ǘƘŜ aƛŎǊƻǎƻŦǘ {v[ {ŜǊǾŜǊ ƛǎ ƭƻŎŀǘŜŘ ƻƴ ŀƴƻǘƘŜǊ ŎƻƳǇǳǘŜǊΦ 
 
¢ƻ ǘŜǎǘ ǘƘŜ ŎƻƴƴŜŎǘƛƻƴ ŎƭƛŎƪ ¢Ŝǎǘ 5.Φ /ƭƛŎƪ !ŘǾŀƴŎŜŘ ǘƻ ƳƻŘƛŦȅ ǘƘŜ ŘŀǘŀōŀǎŜ ŎƻƴƴŜŎǘƛƻƴ ǎǘǊƛƴƎ ǾŀƭǳŜǎΥ 
5ŀǘŀōŀǎŜ bŀƳŜΣ Lt !ŘŘǊŜǎǎΣ {v[ {ŜǊǾŜǊ ¦ǎŜǊ L5 ŀƴŘ tŀǎǎǿƻǊŘΦ 
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To test the connection click Test DB. Click Advanced to modify the database connection string values: 

Database Name, IP Address, SQL Server User ID and Password. 

Video Data Storage Path: This is the location where all the recorded video will be saved. The default is 

the local OS drive (i.e., C). The video folder is created automatically once server configuration is 

completed. You can choose to save video to several different locations: 

Local server drive: For example, C:\video 

Alternate local drive: For example, D:\video 

Shared drive: For example, \ \v5\vshare\HHSvideo 
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1. Add cameras using Auto Discovery, Manual or Add Add/ Remove as needed. See Adding 

Cameras for more information on adding cameras. Click Finish. 

 

2. Click OK. 

3. Click Yes to restart the computer. 
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Use one of the following steps to activate IP Server. 

 

Select Activate by phone.  

Call the phone number displayed. Give the representative your serial number. If you do not have one, 

the representative will ask you for a hardware code. If the account is in good standing you will be given a 

16 digit activation code. Enter the activation code and then click Next. 

Activate Using Demo Mode 

Selecting Demo mode will allow IP Server to operate normally for up to 30 days using up to 99 cameras. 

Once the 30-day period has expired the software will no longer record or display live images. IP Server 

will fail to start until initialization is completed with a valid serial number or activation code. 

Reinstallation is not required. 

Failover Server 

A fault-tolerant feature of IP Server is the ability to designate a failover server. Once designated and 

configured, the failover server can take over from another server that has gone offline. 

To designate a server as a Failover Server: 

1. Click Administration -> Setup and Configuration from the main menu. 

2. Select the desired failover server from the left navigation pane. 

3. Select the Advanced tab. 
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пΦ /ƘŜŎƪ ǘƘŜ ά5ŜǎƛƎƴŀǘŜ {ŜǊǾŜǊ ŀǎ CŀƛƭƻǾŜǊ {ŜǊǾŜǊέ ōƻȄΦ 

 

Avoid selecting a server that is actively monitoring cameras. Figure 4 shows the warning that appears if a 

server with existing cameras is selected as a Failover Server. 

Figure 4: Warning generated when designating a server that is actively monitoring cameras. 

 

If a failure occurs the transfer of the camera(s) to the Failover Server will take approximately 5-10 

minutes to recover. During that time the Monitor Station on the Failover Server will show all cameras 

and images from the offline server and all recorded video will be recorded to the Failover Server or a 

previously configured shared location. 

Note 
You can also access Server Properties by right-clicking the server 
name in the left navigation and selecting Properties, selecting 
the Advanced tab and then selecting Configuring a Failover 
Server.  
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Monitor Station Client 
The Monitor Station client is installed automatically with either IP Server install or IP Server installation 

with an existing SQL installation so a client is easily accessible from the server. In some cases a client-

only install is needed for active visitor monitoring personnel. 

To perform a client-only installation: 

1. Double-click the Setup executable applicable to your system type: 32- or 64-bit OS. 

 

2. Click I Agree to accept the terms and continue the installation. If you do not agree or do not 

want to continue the installation, click Cancel. Select Monitor Station install and then click Next. 
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3. To accept the default destination folder, click Install. To choose another destination enter the 

destination path or click Browse, then click Install. 
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4. When installation is complete, click Next. 

5. Click Finish. 

6. Click Yes if prompted to reboot. 

7. Monitor Station is now installed and ready to be initialized and configured. Double-click the 

Monitor Station icon on your desktop. 

8. Enter login credentials or accept the default login, and click OK to continue. 

9. At least one server must be entered into the Server Setup dialog box before the client can be 

used. 

 

You can enter server information one server at a time or add servers automatically. 

Adding servers manually 

To add a server manually: 

1. In the Server Setup dialog box click Add New. 
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2. Enter the IP address or name of the server to connect to, and the port if different from the 

default. 

3. Click Test to initiate a connection. There are three possible outcomes: 

Login Error: The server is found but security is on and the server attempted to authenticate the login 

with the initial credentials used to login to Monitor Station.  The server default login is 

Administrator/blank for the password). You can still add the server. Then logout of Monitor Station login 

again with the right credentials. 

No Server Found: Either the IP address, server name, server port or both are incorrect. Enter the correct 

values and then click Test again. 

Server Found: The server is found and a successful connection was made using the current credentials 

ό!ŘƳƛƴƛǎǘǊŀǘƻǊκōƭŀƴƪύΦ ¢ƘŜ ǎŜǊǾŜǊΩǎ ƴŀƳŜ ƛǎ ŘƛǎǇƭŀȅŜŘ ƛƴ ǘƘŜ {ǘŀǘǳǎ ŦƛŜƭŘΦ 

4. Click Add. 

5. Repeat steps 1-5 for additional servers if needed. 

6. Click Apply and then OK. 

Adding servers automatically 

In a large organization it is possible to have upwards of 20 video surveillance servers across multiple 

locations. You can easily add a long list of servers at one time using the import feature. 

You need an exported list of servers before you can import them using this feature. The file format is 

.LSL. See the Login section for instructions on how to create this file. 

1. In the Server Setup dialog box click Import List. 

 

2. Enter the file name or click Browse to go to the location of the saved .LSL file. 
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3. Click OK. 

4. If the file is unreadable or not found an error will display. If the import is successful the full list of 

servers will display in the Known Video Servers grid. You will be prompted to restart Monitor Station. 

 

5. Click OK. 

6. Click Apply and then OK. 

7. Restart Monitor Station by clicking the Lock icon on the upper left of the main dashboard. 
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8. Enter the credentials to login to the desired server(s) or click OK to bypass the Login dialog box 

without any credentials. 

Web Client 
You can use the Web Client to view live or recorded video from anywhere using a supported browser. 

Support browsers are: 

¶ Microsoft Internet Explorer with optional ActiveX-plug-in 

¶ Google Chrome  

¶ Apple Safari  

You can use the Web Client to control PTZ cameras and playback recorded video. The system supports 

multiple users and is tightly integrated into the Windows operating system for complete security. 

The Web Client is automatically installed if Microsoft IIS is configured. 

Configuring IIS 

Consult your operating system manual for information on how to install and configure IIS. 

Accessing the Web Client 

Version 5.5 of the Web Client offers: 

¶ Seamless playback 

¶ Simplified navigation 

¶ Intuitive clip creation 

¶ Optional H.264/MPEG streaming  

¶ Snapshot Feature 

¶ Customization 

¶ Advanced configuration 

To start the Web Client: 

1. Start your Internet browser. 
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2. Navigate to ƘǘǘǇΥκκώȅƻǳǊ ǎŜǊǾŜǊΩǎ Lt ŀŘŘǊŜǎǎϐκǾƛŘŜƻƛƴǎƛƎƘǘκŘŜŦŀǳƭǘΦŀǎǇȄ. 

3. If Security is off, you will see servers and cameras ready for viewing. If Security is on a login, a 

prompt displays. 

Note 
The Profile option is used primarily when you are accessing the 
system over the Internet or when you need to limit how much 
bandwidth you use for video. For example, you can have an 
intranet user profile that permits high-speed video over a LAN 
and an Internet user profile that limits video frame rates for use 
on slower Internet connections.  

 
4. Enter your user name and password. 

5. Select a profile from the drop-down menu. 

6. Click Sign In. 

  



Video Insight Administrator Guide   IP Server v5.5 

 

 
Page 40 | Video Insight © 2014 

 

Using the Web Client 

After login the Web Client displays as shown in figure below. 

 

 

 

  

Switch to High 

Speed Mode (HSM) 

to view non-MJPEG 

cameras 

Login details and 

additional menus 

Hide Left Navigation 

Tree Sort IP Servers 

Select the server 

node to display all 

cameras or check 

individual cameras 

instead 

Left tree navigation similar to 

Monitor Station 



Video Insight Administrator Guide   IP Server v5.5 

 

 
Page 41 | Video Insight © 2014 

 

Left navigation tree structure 

The left navigation tree structure in the Web Client functions in much the same way as in the Monitor 

Station. At the top of the tree there are three options for sorting the tree: 

   Enterprise View (default) 

 Facility Map View 

  Layout View 

 

Enterprise View 

Enterprise View is the default view and orders the 

navigation tree based on the server hierarchy. You can use 

this view to display cameras, layouts and facility maps for 

each server. 

You can click the magnifying glass to search all of the 

Enterprise, Facility Maps and Layouts nodes. 

Facility Map View 

Facility Map orders the navigation tree based on the facility 

hierarchy. You can use this view to display cameras and layouts for each facility map. 

 

Selecting a facility map displays it in the viewing pane. 

Moving the mouse over a camera icon on the map brings up 

a live view from that camera. 

Icon indicates 

a PTZ camera 
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Use the arrow controls to move the Facility Map or use the plus and minus controls to zoom in or out. 

Layout View 

Layout View orders the navigation tree based on the layout hierarchy. You can use this view to display 

cameras for each layout. 

Selecting the layout from the tree displays the layout on the right side of the screen. You can also select 

individual cameras from each layout, or mix and match multiple layouts and cameras by checking the 

box next to each item. Expand a layout by clicking the Layout name to view the included cameras. 
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Layouts toolbar 

The collapsible section in the top right offers several different options for layouts. Click the desired 

layout to rearrange the cameras. If the number of cameras selected exceeds the number of cameras 

displayed by the layout view, the extra cameras are viewable on pages accessible at the bottom-right of 

the screen, as shown in Figure x. 
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You can also have a layout automatically selected for the number of cameras checked. For example, if 

only one camera is currently displayed and there are four cameras checked, click the  icon and the 

view will automatically change to the 2x2 layout. 

High Speed mode 

Low Speed mode is the default streaming mode which utilizes higher bandwidth and higher processing 

power on the server. However, you may need a better refresh rate or you may be viewing MJPEG 

cameras High Speed Mode has the added benefit of lower bandwidth. 

To activate High Speed mode: 

1. Click the  button in the Layout toolbar to turn on high speed mode. 

 

2. Click OK. 
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3. Click Install now. 

 

4. After the ActiveX plug-in successfully installs, click OK. 

Configuration menu 

The Configuration menu has several options for further customization. When you make changes to 

options available on this menu they affect ALL other Web Clients connected to the server. 

1. Click Configure. The notification shown in the figure below displays even if Security is on. 

 

2. Click the sign in link. 

 

3. Enter an Administrator-level user name and password and then click Sign In. 

4. Click Configure again. 

You can change options in four catagories: 

Customizable 

Login Message 
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¶ Video 

¶ Navigation 

¶ Content 

¶ Login 

 

Video 

Set to high speed by default ς This option applies to Internet Explorer only and prompts all subsequent 

Web Client connections to install the High Speed Mode ActiveX plug-in. 

Preserve aspect ratio ς All cameras are displayed at a 4:3 aspect ratio for layout and maximized use of 

the vƛŜǿƛƴƎ ŀǊŜŀΣ ōǳǘ ȅƻǳ Ŏŀƴ ŎƘŜŎƪ ǘƘƛǎ ōƻȄ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ŘƛǎǇƭŀȅ ǘƘŜ ŎŀƳŜǊŀΩǎ ŀŎǘǳŀƭ ǊŜǎƻƭǳǘƛƻƴΦ 

The figure below shows a layout without Preserve aspect ratio checked. 

 

The figure below shows the same layout with Preserve aspect ratio checked. 
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Buffer recorded video ς Every time recorded video is played back a temporary file is created in the local 

TEMP directory for faster viewing later. Buffering recorded video this way obviates the need to 

download video files over and over again. You can delete these files from the directory if local storage 

consumption becomes an issue. 

[ƛƳƛǘ ǾƛŘŜƻ ǎǘǊŜŀƳƛƴƎ ǘƻ Ψ·Ω ƳƛƴǳǘŜǎ ς Zero is the default value and means there is no time limit for live 

streaming. You can change this value if you do not want to waste bandwidth on inactive viewers. The 

figure below shows a video session that has timed out due to inactivity. 

 

You can resume streaming by clicking where indicated or refresh your browser. 

Navigation 

 

You can hide the navigation panel by unchecking the box for Show navigation panel. 

Content 

Stretch map to fit screen ς This option stretches a smaller facility map to fill most of the Facility Map 

viewable area. 

Show camera labels ς This option is checked by default, but when unchecked camera names are not 

displayed on the facility map, just the camera icon. 

Show map labels- This option is unchecked by default, but when checked the nested Facility Map name 

displays on the map. 
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Login Message ς This is an empty text field by default. You can use it to display a message up 255 

characters long to Web Client users. The message displays on the main login page when Security is on or 

when accessing the Configure menu. 

The figure below shows a sample message. 

 

Viewing recordings 

You can view a recording using the Web Client by clicking a camera from the live view. When you click a 

camera in the live view it is brought into focus as shown in the figure below. 

 

 

 

The timeline at the bottom indicates the time and type of recording. Orange dots indicate a recording of 

motion events only, and a solid blue line indicates a recording without motion events. 

Still Playing Live 

Timeline View 

Camera Toolbar 

Create a clip 

Playback controls 
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To begin playing, click and hold the time point and drag it left or right, then release it at the point 

desired. 

The figure below shows a camera timeline where the recording type was changed from Motion-only to 

Record Always. 

 

You can expand the calendar on the bottom left to see if recordings are available for a particular day. 

Days with recordings are indicated by orange text. 

 

Camera toolbar 

The camera toolbar at the bottom of the view has several functions: 

 

 

 

Creating a clip 

 

 

To create a clip for later playback or distribution: 

1. Click the  icon. 

 

2. Drag and drop the time point or enter the exact time. 

3. Use the blue handles to lengthen or shorten the clip time. 

Will list all presets, must be 

logged in to use presets 

Click the PTZ button to start 

using PTZ 

Digital Zoom 

After zooming in, 

ǇǊŜǎǎ ǘƘƛǎ ά!Ŏǘǳŀƭ 

Size icon to revert to 

original size 

Reset 

Create a JPEG still image 
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4. Click the  icon to begin the download. 

 

5. When the progress bar reaches 100%, choose whether to save or open the clip. 

 

Health Monitor 
 

To install Health Monitor: 

1. Double-click accsetup.exe. 

 

2. Click Next. 
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3. Click I Agree to accept the License Agreement and continue, or click Cancel to terminate the 

installation. 

 

4. Accept the default destination folder or enter or browse to another location. Click Next. 

5. Click Install. 

 

6. Accept the default Start Menu folder or enter or select another. Click Install. 

7. Click Finish. 

Customization 

 

Video Insight software offers features and capabilities beyond those addressed during installation and 

initial configuration. 
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IP Server 
After IP Server is installed and configured, you can use both Monitor Station and the IP Server Manager 

Utility to customize server settings. Administrative-level access is required to make changes. 

Note 
You can also access Server Properties by navigating to 
Administration, selecting Set up and Configuration and then 
selecting your server.  

To customize IP Server using Monitor Station: 

1. Launch Monitor Station. 

2. Right click the server name in the left navigation pane and select Properties. 

Setup and Configuration tab 

The Server and Configuration tab displays information about the server, database and video storage 

path. It is the same tab that displays during IP Server initalization. 

 

Note 
Recording to a shared location requires a user with write 
permission to that share or recordings will not be saved.  
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Server Name: ¢ƘŜ ŘŜŦŀǳƭǘ ƛǎ άLt {ŜǊǾŜǊ ςάŀƴŘ ǘƘŜ ŘŜǘŜŎǘŜŘ Lt ŀŘŘǊŜǎǎ ƻŦ ǘƘƛǎ ǎŜǊǾŜǊΦ ¸ƻǳ Ŏŀƴ ŎƘŀƴƎŜ ǘƘƛǎ 

to a more friendly or meaningful name. Do not use special characters. 

IP Address: ¢Ƙƛǎ ƛǎ ǘƘŜ ǎŜƭŜŎǘŜŘ ǎŜǊǾŜǊΩǎ Lt ŀŘŘǊŜǎǎ ŀƴŘ ǎƘƻǳƭŘ ƴƻǘ ōŜ ŎƘŀƴƎŜŘΦ 

Version: The current version of the software. 

SQL Server Location: ¢Ƙƛǎ ƛǎ ǘƘŜ ƭƻŎŀǘƛƻƴ ƻǊ Lt ŀŘŘǊŜǎǎ ƻŦ ǘƘŜ ŘŀǘŀōŀǎŜ ǎŜǊǾŜǊΦ Ψ[ƻŎŀƭƘƻǎǘΩ ƛƴŘƛŎŀǘŜǎ ǘƘŀǘ 

the database and Microsoft SQL server are local to the host computer. An IP address in this field 

indicates the Microsoft SQL Server is located on another computer. Click Advanced to modify the 

database connection string values: Database Name, IP Address, SQL Server User ID and Password. To 

change advanced SQL settings, use IP Server Manager Utility. 

Video Data Storage Path: This is the location where all the recorded video will be saved. The default is 

the local OS drive (i.e., C). The video folder is created automatically once server configuration is 

completed. You can choose to save video to several different locations: 

¶ Local server drive: For example, C:\video 

¶ Alternate additional drive: For example, D:\video 

¶ Shared drive: For example, \ \v5\vshare\HHSvideo 

Cameras tab 

The Cameras tab displays information about monitered cameras, unassigned cameras and camera 

licenses. It is a centralized location to manage cameras on a server.
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This license supports: Shows the maximum number of IP cameras allocated to the serial number 

assigned to the server. Using a Video Insight encoder such as the VP16 will show a value of zero in this 

field, but all 16 channels of the encoder can be added. 

The license count adjusts automatically as cameras are added to or removed from a server. 

You selected: The number of cameras in the Cameras to be Monitored pane. 

You can add cameras in two ways: Auto Discovery and Manual Add  

Unassigned Cameras: This field shows all cameras that are not assigned to the selected server. These 

cameras were previously added and removed and remain in the database for reuse. If sharing a 

database with multiple servers you can quickly un-assign cameras from one server and re-assign them to 

another server using this tab. Unassigned cameras do not use a license. 

Click Clear List to permanently delete all unassigned cameras, Delete to permanently delete the 

selected camera, and Load button to load cameras from the database. 

Cameras to be Monitored: This field shows all cameras assigned to the selected server. Each camera in 

this field uses a license. You can reorder their position in the Main dashboard by selecting a camera and 

clicking either the up or down buttons. You can also check the box to sort them alphabetically. 

Advanced tab 

The Advanced tab displays information about server, view and record options. 
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Enable Motion Log: The default for this field is 30 days. The maximum number is 1000. In order for the 

server to save the Motion Log at least one camera must be using Motion-only Recording or Record 

Always with the Calculate Motion Detection checkbox found on each caƳŜǊŀΩǎ wŜŎƻǊŘ ǘŀōΦ !ƭƭ aƻǘƛƻƴ 

Logs can be viewed from either the Alarm Log or Motion Events. 

Enable System Log: The default for this field is 30 days. The maximum number is 1000. The System Log 

is a great way to track user actions, server and camera changes as well as troubleshoot issues. See 

System Log for more information. 

Enable Security: Security is off by default. In this state any user can modify both Client and Server 

settings. Check the box to turn Security on. When checked, both admin and non-admin users must have 

valid credentials to login. See Security for more information on security. 

Designate Server as Failover Server: Check this box to assign the role of Failover Server to this server.  A 

Failover Server is used to assume responsibilities of recording and monitoring in the event that another 

server fails.  

Server timeout sets the timeout period at which point the Monitor Station will no longer receive video 

streams and will pause. Server timeout is set at the server level; however, it is Monitor Stations and 

Web Clients that are checking for activity. Activity is defined as mouse movement. For example, a 

Monitor Station has an active user who is viewing several cameras while actively moving the mouse 

from pane to pane. Another Monitor Station has the application running and a passive user. With a 

Server timeout set to five minutes, the first Monitor Station will remain active while the second Monitor 

Station will eventually pause. The software will stop the video stream when live video is paused. This 

reduces bandwidth consumption. 

Allow only one login per user: Check this box to restrict the number of concurrent logins permitted per 

non-admin users from different IP addresses. Non-admin users can still login multiple times from the 

same computer. Checking this box does not restrict the number of logins an Administrator can have. 

Reserve space for other applications: This option sets the amount of storage that will NOT be used by 

the Video Insight server to record video. The default is 5 GB, regardless of the save location. As 

recording video is a continuous process the server determines when storage is becoming limited and 

approaching Reserve Space, at which point the Server Deletion Routine will initialize to delete the oldest 

video first to free storage for new video. The deletion process only deletes one file at a time, not whole 

folders, to free storage. 

The Server checks the amount of free storage every 5 minutes. When it is smaller than the amount of 

reserved storage the deletion routine executes. If the amount of Server storage is large enough, the 

Server will only need to delete the oldest day folder. If Server storage is extremely small or Reserved 

Disk Space is set high, the deletion routine will delete the current day's video, beginning with the oldest 

hour recorded. 
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Live Display Options: This area of the application will allow you to configure the time in which the server 

will stop displaying live video feeds. 

Note 
Reserve Disk Space is not an exact number; a percentage of the server Total Disk Space is also taken 
into account: Reserved Disk Space = Max (8% x Total Disk Space [Reserve Disk Space]). For example, 
with a 2 TB disk and Reserve Disk Space set to 10 GB, IP Server will reserve 160 GB. In another example, 
with a 50 GB disk and Reserve Disk Space set to 10 GB, we will reserve 10 GB.  

Optimize Video Streams: You can choose Low CPU\High Bandwidth or High CPU\Low Bandwidth 

depending on your ƻǊƎŀƴƛȊŀǘƛƻƴΩǎ ƛƴŦǊŀǎǘǊǳŎǘǳǊŜ ƻǊ ǇƻƭƛŎƛŜǎΦ LŦ ȅƻǳ ŎƘƻƻǎŜ [ƻǿ /t¦\High Bandwidth you 

ǿƛƭƭ ōŜ ǊŜƭȅƛƴƎ ƘŜŀǾƛƭȅ ƻƴ ȅƻǳǊ ƴŜǘǿƻǊƪΩǎ ǇŜǊŦƻǊƳŀƴŎŜ ǘƻ ǎŜƴŘ ǳƴŎƻƳǇǊŜǎǎŜŘ ƛƳŀƎŜǎ ŘƛǊŜŎǘƭȅ ǘƻ ǘƘŜ 

Monitor Station. If you select this option you should carefully consider the resolution size, bit rate and 

FPS and number of cameras you will be using. 

If you select High CPU\Low Bandwidth, video and image compression occurs at the server level. The 

server sends a compressed MPEG4 image to the Monitor Station or Web Client. The server compresses 

the image, sends them and then decompresses them. It allows the system to get a much higher frame 

rate over slower networks. 

Health Monitor tab 

The Health Monitor tab displays information about the Health Monitor service and server. 

Health Monitor is a separate application available in the suite of Video Insight products aimed at 

monitoring the health of your servers. Only one Health Monitor is needed per farm of servers. See 

Health Monitor for instructions on installing and configuring. 
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Enable Health Monitor: Check this box to have the server send a message to Health Monitor in 

preparation for its configuration in Health Monitor. Health Monitor will not be aware of the server until 

ǘƘŜ ǎŜǊǾŜǊΩǎ ǇǊƻǇŜǊǘƛŜǎ ŀǊŜ ŀŘŘŜŘ ǘƻ IŜŀƭǘƘ aƻƴƛǘƻǊΦ 

Version Number: Check this box to send the IP server version to the Health Monitor. 

Lost Signal: Check this box to have the server notify the Health Monitor should a camera lose signal or a 

server stops responding. Time intervals are set in Health Monitor. 

Camera information: Check this box to have the server include camera information when sending 

camera issues to Health Monitor. 

Server Name: ¢ƘŜ Lt {ŜǊǾŜǊΩǎ ƴŀƳŜ ƛǎ ǘƘŜ ŘŜŦŀǳƭǘΦ ¸ƻǳ Ŏŀƴ ŜŘƛǘ ǘƘƛǎ ŦƛŜƭŘΦ 

IP Address: Enter the IP address of the Health Monitor server. 

Server Port: The Health Monitor server port defaults to 11000. If this port is already in use, open 

another port and enter it here. 

Send Frequency: The default is to send an email every minute. You can select interval of one minute to 

24 hours. 

Client Tab 

The Client tab displays information about client communications. 
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Use Data Port: The port the IP Server uses to send live video to the Monitor Station. 

Command Port: The port the Monitor Station uses to get and set system information. 

Maximum Connections: The maximum number of Monitor Stations that can be connected to the server 

at one time. Additional processing power is required for each remote client connected. 

Launch Group Policy Editor: This is an administrator feature in environments where the organizational 

security policy for video monitoring personnel is extremely limited. An administrator with appropriate 

credentials on the Monitor Station can launch the Microsoft Windows Group Policy Editor from this tab. 

SMTP Server: 9ƴǘŜǊ ǘƘŜ {a¢t ǎŜǊǾŜǊΩǎ Lt ŀŘŘǊŜǎǎ ƻǊ ƛǘǎ ƴame. 

SMTP Port: The default SMTP port is 25. 

SMTP Logon Information: Checking the box for SMTP server requires authentication and enter the 

SMTP user name and password here. Missing or invalid credentials can result in emails not being sent to 

the intended recipients. 

If the SMTP server uses SSL encryption for incoming and outgoing messages, check the box for SMTP 

server requires encryption. 



Video Insight Administrator Guide   IP Server v5.5 

 

 
Page 59 | Video Insight © 2014 

 

Send Test Email: Enter an email address to send a test email to. Leave the default From email address 
TestMessage@IpVideoServer.net or enter another. You can also leave it blank, but some SPAM filters 
may prevent the email from going through without a From address. 

Click Send to send a test email like shown in the figure below. Two entries will also be made in the 

System Log. 

 

Depending on the performance of your infrastructure, it may take a few minutes for the email to be 

routed from the Monitor Station to the IP Server, then to the SMTP server and finally to the destination 

inbox. 

Access Configuration tab 

The Access Configuration tab displays information about access control options and doors. It is used to 

configure various access configuration systems. See Access Control Configuration for more information 

on access control configuration. 

 

mailto:TestMessage@IpVideoServer.net
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See BlackBoard and MonitorCast for more information on configuring these systems. 

Contact Information tab 

The Contact Information tab displays contact information for the server. 

 

The only default value on this tab is the Server Name. An Administrator can enter server information. 

IP Server Manager 
The IP Server Manger (IPSM) application is used to manage and troubleshoot advanced server settings. 

It is installed at the same time as IP Server. 

The IPSM: 

¶ Monitors the IP Server and presents visual status cues for each servers 

¶ Provides a Diagnostics version of the IP Server Manager for troubleshooting and system 

optimization 

¶ Manages IP Server network connections 

¶ Manages licensing and registration 

¶ Manages Lightweight Directory Access Protocol (LDAP) and Active Directory configuration 

Options available in IPSM vary slightly depending on the installation type. See Installation for more 

information on installation types. 
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Accessing IPSM 

The IPSM icon resides in the Windows System Tray. It has two possible states: 

= Server is functioning properly; streaming video to clients, recording video and reporting to Health 

Monitor, if applicable 

 = Server is stopped and is NOT streaming or recording video 

You can configure IP Server, manage the IP Server service, exit the application and see information 

about Video Insight by right-clicking on the IPSM icon. 

 

Select Server Configuration to manage the IP Server service, configure IP Server and terminate the IPSM 

application. 

Select Start IP Server, Stop IP Server or Restart IP Server to start, stop or restart the IP Server service. 

Select Exit IP Server Manager to terminate the IPSM application and remove the icon from the Windows 

System Tray. 

Note 
Terminating the application prevents clients from remotely 
restarting the IP Server service.  

Select About Video Insight to display version information, technical support information and legal terms. 

Configuring IP Server 

You can manage service controls and configure IP Server by right-clicking the IPSM icon in the Windows 

System Tray and selecting Server Configuration. 
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The Service Controls Status field displays IP Server service status. Click Start, Stop or Restart to start, 

stop or restart the IP Server service. 

Clicking Close closes the IP Server Manager dialog box but does not exit IPSM. To exit the IPSM 

application, click Exit IP Server Manager to terminate the IPSM application and remove the icon from 

the Windows System Tray. 

Note 
Terminating the application prevents clients from remotely 
restarting the IP Server service.  

Click a configuration button to perform other functions: 

¶ Options ς configure options to automatically restart the server on a schedule 

¶ System Log ς view the current system log 

¶ Network Options ς configure connection options 

¶ Diagnostics ς stop the IP Server service and run the diagnostic version 

¶ No Cameras ς run Diagnostics with cameras not started 

¶ Update Activation ς update the activation code 

Each function is detailed below. 
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IPSM: Options 

Clicking Options brings up the Auto Restart Options dialog box. This dialog box offers several settings 

aimed at mitigating some organizational and server environment settings that could interfere with the IP 

Server service. 

Auto Restart 

Restarting the service can refresh streaming, bandwidth and CPU performance by releasing used 

resources. You can choose to automatically restart the service on a specific day and time. This flexibility 

to restart means that you can schedule it so as to not interfere with business hours. 

 

To set an auto-restart schedule: 

1. Check the Enable box. 

2. Select the restart day or days. 

3. Select a restart time. 

4. Click OK. 

Delay Service 
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Delaying the IP Server service start is an option to consider if the server has many services that have to 

start in addition to the IP Service. The IP Server service may have trouble initializing without services 

such as the Microsoft SQL database service already running. 

 

To set a startup delay: 

1. Check the Enable Startup Delay box. 

2. Select the startup delay time in seconds. 

3. Click OK. 

Options 

In environments where both an Analog and an IP server are installed on the same server, and where 

bandwidth resources will likely be very highly utilized as a result, there is an option to restrict the Analog 

ǎŜǊǾŜǊΩǎ ōŀƴŘǿƛŘǘƘ ŎƻƴǎǳƳǇǘƛƻƴΦ 
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Enabling this option will terminate communication between the Analog and the IP server and no live 

streaming or recording will be done by the IP server when the timeout threshold has been reached. 

For example, in a scenario with the timeout enabled and set to 30 seconds, there is a Monitor Station 

layout comprised of both analog and IP camera images. For 30 seconds, both streaming and recording is 

managed by the IP Server. When 30 seconds have passed the analog cameras will stop streaming and 

recording due to this feature. Changing the layout will restart streaming and recording for all cameras 

until the timeout is reached again. 

To set an analog video timeout: 

1. Check the Enable Analog Video Bandwidth Timeout box. 

2. Select the timeout in seconds. 

3. Click OK. 

IPSM: System Log 

Clicking System Log will bring up the System Log dialog box. The System Log documents warnings, 

errors, security and informational messages related to various system functions. Each message may or 

may not appear depending on the configuration and whether security is enabled on the server. 
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IPSM: Network Options 

Clicking Network Options brings up the Network Options dialog box. This dialog box is used for selecting 

the network scheme when a server has dual NIC cards or changing the communication port of the 

server. You can also modify Active Directory and LDAP settings. 
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Note 
If you change the Communication Port here, you must also 
change the command port in Server Properties.  

IPSM: Diagnostics 

Clicking Diagnostics brings up the Video Server Diagnostics interface. This interface is used for 

troubleshooting any service related issues. The IP Server service is stopped when Diagnostics is 

launched; however, recording and live streaming continue normally. The difference is that Video Server 

Diagnostics has a user interface and the IP Server service is a background process without a user 

interface. 
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Server name: This field displays the server name previously entered. It is not editable. To change the 

name of the server, click Setup and configuration in the left pane or from Server Properties. 

IP Address: ¢Ƙƛǎ ŦƛŜƭŘ ŘƛǎǇƭŀȅǎ ǘƘŜ ǎŜǊǾŜǊΩǎ Lt ŀŘŘǊŜǎǎ ŀƴŘ ǎƘƻǳƭŘ ƴƻǘ ōŜ ŎƘŀƴƎŜŘΦ 

Port: This field displays the port used by the Monitor Station to get and set system information. This 

port is also referred to as the Command Channel Port. See list of ports for more information on ports 

used by the software. 

Version: This field displays the software version. 

Max cameras: This field displays the maximum number of cameras allocated to the serial number 

assigned to the server. Using a Video Insight encoder such as the VP16 will show a value of zero in this 

field, but all 16 channels of the encoder can be added. 

Available: This field displays the number of licenses available to add to the server. 

The grid area of the Diagnostics interface is read-only and displays all cameras, the last video write time, 

if it is recording and the time the last image was received, or the last time a live image was received 

from the camera. 

Time of last write: ¢Ƙƛǎ ŎƻƭǳƳƴ ŘƛǎǇƭŀȅǎ ǘƘŜ ƭŀǎǘ ǘƛƳŜ ǘƘŜ ŎŀƳŜǊŀΩǎ ƛƳŀƎŜǎ ǿŜǊŜ ǊŜŎƻǊŘŜŘ ǘƻ ŀ ŦƛƭŜΦ ! 

time of 12:00:00 AM is indicative of a camera that is set to Recording Off or not recording due to a 

Motion-Only recording type. 

Last image received: ¢Ƙƛǎ ŎƻƭǳƳƴ ŘƛǎǇƭŀȅǎ ǘƘŜ ƭŀǎǘ ǘƛƳŜ ǘƘŜ ŎŀƳŜǊŀΩǎ ƭƛǾŜ ƛƳŀƎŜǎ ǿŜǊŜ ǎǘǊŜŀƳŜŘΦ ! ǘƛƳŜ 

of 12:00:00 AM is indicative of a camera that is offline. The camera could be offline for several reasons: 
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incorrect credentials, network, bandwidth or the IP Server service not running. See the FAQ section for 

more information on why a camera could be offline. 

To view the Setup and Configuration section of Video Server Diagnostics click that node from the left 

pane. 

 

With the exception of the Access Configuration tab available in IP Server properties the tabs in this view 

are the same as Server Properties accessed from the Monitor Station. The cameras listed in the left pane 

can be managed in this view. /ƭƛŎƪ ǘƘŜ ŎŀƳŜǊŀ ƻƴ ǘƘŜ ƭŜŦǘ ŀƴŘ ǘƘŜ ŎŀƳŜǊŀΩǎ properties will be displayed. 

Note 
Remember to start the service when exiting the Diagnostics 
application.  
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See Modifying Camera Details for more information on camera property tabs. 

Two additional features for troubleshooting are available that are not available in Monitor Station, by 

highlighting the server node in the left pane: Test DB and Advanced. 

Click Test DB to test connectivity to the database.  The database test will pass when the server makes a 

successful connection to the database. If it does not, the ǘŜǎǘ ǿƛƭƭ ŘƛǎǇƭŀȅΥ ά9ǊǊƻǊΥ 5ŀǘŀōŀǎŜ ǾŜǊǎƛƻƴ ƛǎ ƴƻǘ 

correct. Either the database did not respond, nor Ƙŀǎ ŀƴ ƻǳǘŘŀǘŜŘ ǾŜǊǎƛƻƴΦέ ¢ƘŜǊŜ ŀǊŜ ǎŜǾŜǊŀƭ ǊŜŀǎƻƴǎ 

why the database test failed. See FAQs for possible reasons for and potential solutions to the failure. 

Incorrect database information may be one cause of test failure. To update or confirm the information 

click Advanced.  

Database: Enter the database name. The default database name 

is InsightEnt. 

IP Address: Enter either the IP address or the hostname of the 

database server. 

User ID: The default user ID for the InsightEnt database is sa. 

Password: The default password for the InsightEnt database is 

vinsight. 
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Video Server Diagnostics offers a live view feature. Clicking Live View in the left pane display a separate 

window with all of the cameras added to the server. 
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You can view the System Log by clicking the node in the left pane. See System Log for more information 

on the system log. 

 

IPSM: No Cameras 

Another troubleshooting option is a diagnostics version that can run the application without starting any 

cameras. This version does not consume any bandwidth. 

This version functions the same as the other version, with the exception that camera-related features 

and information such as Live View and Time of last write are not available after this diagnostics version 

is started. See IPSM Diagnostics for more information on running diagnostics. 

IPSM: Update Activation 

The Update Activation option is used to update the Activation type (e.g., transitioning from Demo to 

purchased licensing scheme) or when the serial number used is upgraded with additional licenses. 
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See Installation for more information on changing the activation type. Click OK to confirm the number of 

licenses currently available. 

 

Monitor Station 
 

Monitor Station is the primary user interface in the product suite and can be considered the hub from 

which all configurations and monitoring is done. Configuration changes to the Monitor Station will only 

affect the local host and not the server or other clients, unless Administrator-level access changes are 

made in Setup and Configuration. 
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Main Dashboard 

 

The main dashboard has many features to make daily monitoring easy and manageable. It is the first 

view to appear after starting Monitor Station. 

 

 

 

 

 

 

 

Main menu toolbar 

¢ƘŜ aƻƴƛǘƻǊ {ǘŀǘƛƻƴΩǎ Ƴŀƛƴ ǘƻƻƭōŀǊ Ƙŀǎ ǎŜǾŜǊŀƭ ƳŜƴǳǎΥ Tools, Administration and Help. 

 

Click the Lock to 

log out and back in 

when restarting 

the MS for changes 

to take affect 

Main menu toolbar with a 

slew of options 

Layout toolbar) 

Left Navigation 

tree of servers, 

cameras, 

layouts, facility 

maps, Action 

buttons and 

HM access 

Cameras 

live view 

PTZ 

Controls 

pane 

Search 

Pane 

Live Audio Controls 

Panel 

Number of connected servers. 

Click View>Status>Server Status to hide this 

information bar 

/ŀƳŜǊŀΩǎ ǉǳƛŎƪ 

Access toolbar 

Quick launch Media 

Player 

/ŀƳŜǊŀΩǎ ƴŀƳŜ 
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File 

The File menu has two selections: Media Fixer and Exit. Media Fixer is used to fix corrupted video files 

and Exit terminates the program. 

File>Media Fixer 

Media Fixer helps you fix corrupted media files. 

1. Click the File menu and select Media Fixer. 

 

2. Click Next. 
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3. You can add a single video file, multiple video files or folders of video files to be fixed. The path 

to each file will be displayed after is it added. 

 

4. Click Next. 
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5. For best results let Media Fixer attempt to read the file information. If you choose to specify the 

file information it is crucial to provide the correct file header information. Attempting to fix it with 

incorrect information may render the file unusable. Click Fix Files. 

 

6. The Status dialog box displays progress. When the wizard is complete it will display the path of 

the fixed file. 
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7. ¢ƘŜ ŦƛȄŜŘ ŦƛƭŜ ǿƛƭƭ ƘŀǾŜ άŦƛȄŜŘέ ŀǇǇŜƴŘŜŘ ǘƻ ǘƘŜ ŦƛƭŜ ƴŀƳŜΦ ¢ƘŜ ƻǊƛƎƛƴŀƭ ŦƛƭŜ ǎǘƛƭƭ ŜȄƛǎǘǎ ŀƴŘ Ƙŀǎ ƴƻǘ 

been altered. 

 

8. Click Finish. 

File>Exit 

Click the File menu and select Exit. Monitor Station will display a prompt to confirm exiting the 

application. This behavior is exactly as if you were to press the Lock Icon. 

 

You can also exit the application without having to make the confirmation by unchecking the Exit 

confirmation checkbox on the Tools>Options>General tab. 

View 

The View menu has six selections: Archive Tree, Full Screen, Layout, Mini Toolbars, Status and Toolbars. 

View>Archive Tree 
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The Archive Tree option is checked by default. If unchecked the left navigation tree will be hidden. This 

is useful if you want to have more space within the application for live view streaming. 

The default view with Archive Tree selected is shown in the figure below: 

 

The view with Archive Tree deselected is shown in the figure below. 
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View>Full Screen 

Selecting Full Screen expands the main dashboard view to fill your display. Pressing the F11 key on your 

keyboard performs the same function. 

View>Layout 

Selecting Layout shows the full list of the predefined camera layouts. Selecting one of the layouts 

displays the selected number of cameras in the main dashboard view. Pressing the related Function key 

on your keyboard performs the same function. 
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View>Mini Toolbars 

Selecting Mini Toolbars creates Cycle Layouts and PTZ Controls function boxes that can be repositioned 

anywhere on your dashboard for easy access. 

Cycle Layouts 

Security personnel may be assigned to a particular area and may only need to review certain locations. 

In practice, locations are usually grouped by server. For example, one Monitor Station may be 

connected to multiple sites, with one Server per site. As each site may have a different number of 

cameras you may have a different layout for each site. You can perform a virtual walkthrough of each 

site by cyŎƭƛƴƎ ŜŀŎƘ ǎƛǘŜΩǎ ƭŀȅƻǳǘΦ 

You can cycle layouts two ways: manually or automatically. You can manually cycle layouts by pressing 

any of the predefined Layout buttons as shown in the figure below. 

 

To configure the one server cycling for manual selection: 

1. Click the Tools menu and then select Options. 

2. hƴ ǘƘŜ DŜƴŜǊŀƭ ǘŀō ŎƘŜŎƪ ǘƘŜ ōƻȄ ŦƻǊ ά¦ǎŜ ǘǊŜŜ ƴŀǾƛƎŀǘƛƻƴ ǎŜǊǾŜǊ ǎŜƭŜŎǘƛƻƴ ŦƻǊ ŘŜŦŀǳƭǘ ƭŀȅƻǳǘ 

ōǳǘǘƻƴǎέΦ 

Use the shortcut 

keys on your 

keyboard to 

change the 

layout 
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3. Log out and back in to the Monitor Station to refresh the settings. 

4. Select the highlighted server from the left navigation tree. 

5. /ƭƛŎƪ ŀƴȅ ƻŦ ǘƘŜ [ŀȅƻǳǘ ōǳǘǘƻƴǎ ŀƴŘ ƴƻǘƛŎŜ ǘƘŀǘ ƻƴƭȅ ǘƘŜ ǎŜƭŜŎǘŜŘ ǎŜǊǾŜǊΩǎ ŎŀƳŜǊŀǎ ǿƛƭƭ ōŜ 

selected for the layout view. 

To configure the one server cycling for automatic selection: 

1. Click the Tools menu and then select Options. 

2. On ǘƘŜ ¢ƻƻƭǎ /ƻƴŦƛƎǳǊŀǘƛƻƴ ǘŀō ŎƘŜŎƪ ǘƘŜ ōƻȄ ŦƻǊ ά[ŀȅƻǳǘǎ ŎȅŎƭŜ ǘƘǊƻǳƎƘ ŎǳǊǊŜƴǘ ǎŜǊǾŜǊέΦ ¢Ƙƛǎ 

box is checked by default. 
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3. Log out and back into the Monitor Station to refresh the settings. 

4. Click the View menu, select Mini Toolbars and then select Cycle Layouts. 

5. Click the desired Layout scheme and click the Play icon. 

 

PTZ controls 

You can control PTZ operations for PTZ-capable cameras from different areas in the application. Each 

area offers a slight variation in capability. 
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Note 
PTZ Operations can also be launched by clicking the Tools menu 
and selecting PTZ Operations. To start the PTZ Controls function 
box, click the View menu, then Mini Toolbars and then PTZ 
Controls. The figure below describes the different functions 
available.  

The following figures describes the left navigation tree PTZ Controls pane  

 

 

 

 
 

 

 

 

 

 

 

. 

 

 

 

 

 

 

Also called Home button, 

once pressed will return 

the camera to the home 

position if camera supports 

this feature.  This icon will 

not appear if camera does 

not support this feature. 

Use arrows 

to pan left 

right, up or 

down 

PTZ sensitivity slider; 

higher the setting the 

longer distance one mouse 

click will move.  Setting it 

to lowest position will 

require multiple mouse 

clicks to move the camera 

further. 

Will select the next PTZ 

capable camera on the 

server to mange 

Camera name 

Once clicked will move 

the camera to the next 

saved preset location 

Close or Open shutter if 

exists on camera 

Focus near 

or far 

Digital Zoom Joystick capability 
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Clicking Live Window launches a live view of the selected camera. This window can be used to 

manipulate the live view using the PTZ controls. 

 

You can use the PTZ Operations pop-up with its expanded features to create and manage PTZ presets. 

PTZ presets are predefined views that can be used for cycling or manually going to a camera with a click 

of a button during live view from the main dashboard. 

Creating a preset 

Select the server 

name from the 

dropdown 

Select the PTZ camera to 

move.  Only PTZ capable 

cameras will appear in this 

dropdown 

Zoom in or out 

List of camera presets 
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1. Launch the PTZ Operations pop-up. 

2. Select the server and camera from the drop-down menu. 

3. Click Live View to view the camera as it is being moved. 

4. In Live Window move the camera to the desired preset location. 

5. Click Add. 

 

6. Enter a label for the preset. 

7. Click Add. 

8. The newly-added Preset appears in the Presets pane. 

 

9. Continue moving the camera to the second position and repeat steps 4-7 to add as many 

presets as required. A maximum of 32 presets are supported depending on the camera. 

To remove a Preset, select it from the Presets pane and click Delete. 

 

Click Yes to permanently remove it or No to cancel the operation and return to the PTZ Operations 

screen. 

You can also cycle automatically through presets by navigating to the Cycle Presets tab and clicking 

Start. 
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Added Presets can also be selected from the Live view camera toolbar in the Main Dashboard as shown 

in the figure below. 

 

View> Toolbars 

You can hide additional options displayed by default in the main dashboard by clicking the View menu 

and selecting Toolbars. Hiding them will add space to the live view. 

1. Click the View menu and select Toolbars. 

 

2. Three sub options are checked by default. Unchecking all three will hide the following Main 

Dashboard items: 

 

 

Login Layouts Widescreen Layouts 
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Tools>System Log 

You can access the System Log from several different areas of Monitor Station and Diagnostics.  

Tools>Axis Joystick Control 

The Axis Joystick Control supports the Axis Joystick. This USB joystick replaces a mouse for control of 

Axis PTZ-capable cameras. 

After the joystick is connected, click the Tools menu and select Axis Joystick Control. 

 

Up to 10 Axis PTZ-capable cameras added to a server in a Monitor Station will automatically populate 

the Axis Joystick Control, including the IP address and port. 

¸ƻǳ Ŏŀƴ ƳŀƴŀƎŜ ŀƴȅ ƎŀƳŜ ŎƻƴǘǊƻƭƭŜǊΩǎ ǎŜǘǘƛƴƎǎ ŀƴŘ ŦƛǊƳǿŀǊŜ ōȅ ŎƭƛŎƪƛƴƎ Config. 
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{ŜƭŜŎǘ ǘƘŜ ŎƻƴǘǊƻƭƭŜǊ ȅƻǳΩŘ ƭƛƪŜ ǘƻ ƳŀƴŀƎŜ ŀƴŘ ŎƭƛŎƪ Properties. 

 

¸ƻǳ Ŏŀƴ ǘŜǎǘ ŀƴŘ ŎŀƭƛōǊŀǘŜ ǘƘŜ ŎƻƴǘǊƻƭƭŜǊΩǎ ǎŜǘǘƛƴƎǎΦ /ƭƛŎƪ Apply and then OK. 

If you click the Tools menu and select Axis Joystick Control without having an Axis Joystick attached, an 

error displays. 
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¸ƻǳ Ŏŀƴ ŎǳǎǘƻƳƛȊŜ ǘƘŜ ƧƻȅǎǘƛŎƪΩǎ ǇŀƴΣ ǘƛƭǘ ŀƴŘ ȊƻƻƳ ǎensitivity by clicking the Settings tab. 

 

Enter the user name and password if credentials are required to change the joystick configuration. 

Note 
The Layouts drop-down list will not appear if no Layouts exist.  

Tools>Live Window 

You can use Live Window as a free-floating single or multi camera view. It is 

another feature that is accessible from several different areas of the 

application. It also has slightly different options depending on where it is 

accessed. 

Figure shows Live Window when launched from the main toolbar. 
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You can select the server name or IP address from the Server drop-Řƻǿƴ ƳŜƴǳΦ ¢ƘŜ ǎŜǊǾŜǊΩǎ ŎŀƳŜǊŀόǎύ 

becomes available for selection from the Camera drop-down menu. In addition, all Layouts for all 

servers in that Monitor Station become available in the Layouts drop-down menu. 

The red line bordering the Live Window image signifies that motion was detected on this camera. To 

remove the motion indicator click the Tools menu, select Options, then select the Live Window tab and 

uncheck the box for Red Outline on Live Window. 

Tools>Media Player 

Media Player is a standalone video player created by Video Insight. It has many capabilities and is built in 

to Monitor Station. See Media Player for more information. 

Tools>PTZ Operations 

See PTZ Controls for more information on PTZ Operations. 

Tools>Synchronized Player 

Synchronized Player allows for synchronized playing of multiple cameras. See the Synchronized Player 

section for more information. 

Tools>Options 

You can use Options for additional configuration and personalization of your Monitor Station. 
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General tab 

 

Exit confirmation: By default, closing Monitor Station displays a confirmation dialog box. To avoid this 

message uncheck this box. 

 

Block warning messages: By default, Monitor Station warning messages informs you of cameras that 

lose connectivity, when the connection is restored and any disk write errors that occur. To avoid these 

warning messages check the box. 

Integrated player initial size:  The Integrated Player size is the size of the player when playing files from 

the Main Dashboard. Changes made here do not affect Media Player size. Available sizes are: 320x240, 



Video Insight Administrator Guide   IP Server v5.5 

 

 
Page 93 | Video Insight © 2014 

 

400x300, 480x360, 560x420, 640x480, 720x540, 800x600, 960x720, 1080x810, 1280x960, 1440x1080 

and 1600x1200. 

 

Show layout: ¢Ƙƛǎ ƻǇǘƛƻƴ ŘŜǘŜǊƳƛƴŜǎ ǿƘŜǘƘŜǊ ǘƘŜ ŎŀƳŜǊŀΩǎ ǘƻƻƭōŀǊ ƛƴ [ƛǾŜ ǾƛŜǿ ǿƛƭƭ ŘƛǎǇƭŀȅ ƻǊ ƴƻǘΦ Lǘ ƛǎ 

checked by default. When unchecked, more of the screen is used to view the live image of the camera(s) 

rather than displaying camera information. 

When this option is checked it will display camera information as shown in the figure below. 

Note 
Choosing a player size mismatched to your display and 
resolution can prevent you from seeing the Controls bar at the 
bottom of the player.  
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When this option is unchecked, it will not display camera header information. 

 

Show server name: By default, this option displays the server name in the camera toolbar in the main 

view as well as in the server and camera Live Window pop-ups. The Show layout option must also be 

checked for this information to appear. 

Show camera name: By default, this option displays the camera name in the camera toolbar in the main 

view as well as in the server and camera Live Window pop-ups. The Show layout option must also be 

checked for this information to appear. 
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Force aspect ratio: This option is another customization for achieving the best layout on your display.  

With Force aspect ratio checked, all live images will be forced to a 4:3 size in the main layout as shown 

in the figure below. This option does not affect Live Window pop-ups. 

 

 

Use DirectX display: This option reduces CPU usage by attempting to use DirectX rather than the 

onboard or installed graphics device. If checked, you must select the correct version of DirectX installed 

on the computer: DirectX 9, 7 or Legacy for versions older than 7. 

LŦ ǘƘŜ 5ƛǊŜŎǘ· ǾŜǊǎƛƻƴ ǎŜƭŜŎǘŜŘ ƛǎ ƴƻǘ ƛƴǎǘŀƭƭŜŘ ƻƴ ǘƘŜ ŎƻƳǇǳǘŜǊΣ ǘƘŜ ŜǊǊƻǊ ƳŜǎǎŀƎŜ ά/ŀƴƴƻǘ LƴƛǘƛŀƭƛȊŜ 

ǊŜƴŘŜǊŜǊ όлȄуллплнтоύέ ŘƛǎǇƭŀȅǎΦ {ŜƭŜŎǘ ǘƘŜ ŎƻǊǊŜŎǘ ǾŜǊǎƛon of DirectX or uncheck the option. 

Note 
This capability will affect only the first four cameras in live view 
and Layouts.  

Double click expands camera: This option specifies whether a single- or double-click is required to 

expand the camera in the left navigation tree to show its recordings. If this option is selected a single 

click on the camera only displays the camera in the viewing panel. 

Use tree navigation server selection for default layout buttons: ¢Ƙƛǎ ƻǇǘƛƻƴ ŘŜǘŜǊƳƛƴŜǎ ǿƘƛŎƘ ǎŜǊǾŜǊΩǎ 

layouts will be used when cycling manually or automatically. See Cycle Layouts for more information on 

cycling layouts. 
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On Screen Controls (for PTZ Cameras): The default is On Screen PTZ. It superimposes directional arrows 

on the view for PTZ cameras to signify a PTZ camera is selected in live view on the main dashboard. 

 

Selecting Overview Window displays a magnifying glass as a cursor in the live view. To zoom in on an 

area, draw a square with the cursor. The figure below shows an example of a square drawn on the view. 

 

 

 

 

Selecting None does not display any special cursors for PTZ cameras. Use the PTZ Controls function box 

found in the left navigation tree. 

On Screen Controls (for Standard Cameras): The default is Overview Window. It displays a magnifying 

glass as a cursor in the live view. 

Overview Window 

of full camera view Zoomed in area; to move it drag 

the orange square within the 

Overview Window 
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To zoom in on an area, draw a square with the cursor. Standard cameras use a digital zoom. The figure 

below shows an example of a square drawn on the view. 

 

 

 

 

Selecting None disables the ability to digitally zoom in live view for standard cameras. 

  

Overview Window 

of full camera view 

Zoomed in area; to move it drag 

the orange square within the 

Overview Window 
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Tools Configuration tab 

 

You can choose from three bandwidth-related options to optimize the live view performance in Monitor 

Station. 

Normal operation: This option uses all available resources to display live streaming. This option is 

sensitive to network bottlenecks and should only be used for clients with very good connectivity. 

Normal streams all images as uncompressed MJPEG. 

Note 
If the Low Bandwidth\High CPU option is selected at the server, 
client options are ignored as all images are already compressed.  
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Low bandwidth mode:  Select Low bandwidth mode if you are viewing multiple images over moderate 

network bandwidth. This option compresses multiple images. If you switch to a single image view it will 

send that image as uncompressed. 

Very low bandwidth mode: In Very low bandwidth mode all images are compressed. Choose this option 

for clients with poor connectivity. 

You can use the Machine Performance drop-down menu to choose from three options to improve live 

streaming when using multiple camera views. This option improves performance when viewing layouts 

with nine or more cameras. 

Normal: When selecting this option expect the Monitor Station to use the current capabilities of your 

ŎƭƛŜƴǘ ƳŀŎƘƛƴŜΩǎ /t¦. 

Workstation: The Monitor Station will use approximately the same amount of CPU as in Normal mode 

when viewing a four camera layout and a higher performance of live streaming. If you view a layout with 

nine or more cameras you will see an increase in CPU usage because more cameras are visibly streaming 

with better live performance. 

High Performance: The Monitor Station will use the most CPU to deliver the smoothest live view with 

layouts of 16 cameras or more. This option should be selected only if the Monitor Station host has a 

powerful CPU. 

Mini Toolbars (for cycling layouts): See Cycle Layouts for more information on cycling layouts. 

Local Settings: You can export your Monitor Station settings two ways. 

 

To export your Monitor Station settings: 

1. Select Use Registry or Use XML as the export method and then click Export. 
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2. Enter a name for the export file and select a save location if different from the default, then click 

Save. 

Export files are saved in XML format. The figure below shows a sample export file. 

 

You can use this file to configure other clients. Click Import in the same area to import the previously 

exported file. 

Enable Access Control Lane Viewer: This option is for BlackBoard access control integration. 

Note 
BlackBoard and other access control integrations are discussed 
beginning on page 241.  
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Lock down Access Control Lane Viewer: This option is for BlackBoard access control integration. 

View Sentry 360 cameras in Quad View when in single camera mode: Left unchecked, Sentry 360 

cameras offer multiple views: Full image, Quadview and Panoramic. The figure below shows an example 

of this view. 

 

You can check the option and if the camera is selected from the main dashboard or the left navigation 

tree only the quad view displays. The figure below shows an example of this view. 

 

Creating clips (Enable Watermark): By default, this option interlaces the Checksum security mark to 

detect any tampering with the created clips. See [topic] for more information on creating clips. 
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Creating clips (Force Motion JPEG Format for Clips): By default, this option creates all clips in Motion 

JPEG format. Motion JPEG is a format that can be read by most software media players. 

Live Window tab 

 

 

Block live window pop-ups: This option is unchecked by default. If checked, it suppresses all Live 

Windows from popping up while Monitor Station is active. Live Windows can be sent to you from other 

users, by rules or manual launch. 

Live window always on top: This option is unchecked by default. If checked it shows all received Live 

Windows on top of Monitor Station. 

Integrated Facility Map: Selecting this option displays a Facility Map in the main dashboard area of 

Monitor Station on the left side of the left navigation tree. See Facility maps for more information on 

creating, maintaining and using facility maps. The figure below shows an example of a facility map. 
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Use Four Camera Facility Map display: You can apply this option to both integrated and non-integrated 

maps. The four camera view is very useful when attempting to seam together a four eye camera to view 

a complete hallway at once, such as the Arecont 180 or 360 cameras. This view can also be used for 

other cameras, as shown in the figure below. 

 

Force record option: Checking this option adds a button to the Camera Toolbar in the Main Dashboard. 

Clicking this button immediately records, and will continue to record, until the button is clicked again or 

the time set has been reached (maximum of 200 minutes). 
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Selecting this option does not permanently change the cŀƳŜǊŀΩǎ ǊŜŎƻǊŘƛƴƎ ǘȅǇŜΦ /ƭƛŎƪƛƴƎ the Force 

Record button forces the camera to record and when complete the camera will resume its normal 

recording setting. 

Red Outline on Live Window: You can launch Live Window by right-clicking on the server node from the 

left navigation tree. It displays all cameras for that server and outlines each with a red line for a few 

seconds when motion is detected, as shown in the figure below. 

 

Pause main display when live window launches: If you launch Live Window from a server or from the 

left navigation tree or for a single camera, the main dashboard will pause all streaming to improve 

performance and conserve bandwidth. The paused images will appear gray after a few seconds. 

Force Record Button 
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To resume live streaming when closing the live window, click Pause. 

Include Server Name for All Facility Maps: Facility maps are available in the left navigation tree for quick 

access, but when multiple servers are added to a single Monitor Station it can be difficult to determine 

which facility maps belong to which server. You can add the server name to make it easier. If checked, 

the server name will preface the Facility Map name, as shown in the figure below. 

 

Include Server Name for All Layouts: Layouts are available in the left navigation tree for quick access, 

but when multiple servers are added to a single Monitor Station it can be difficult to determine which 

 Paused images 



Video Insight Administrator Guide   IP Server v5.5 

 

 
Page 106 | Video Insight © 2014 

 

layouts belong to which server. You can add the server name to make it easier. If checked, the server 

name will preface the Layout name, as shown in the figure below. 

 

Layout tour cycle time: You can set the time interval between each camera on a tour. The default is five 

seconds.  

Rules Manager Triggered Actions: Creating rules adds flexibility and customization to your software.  

Rules can include results that send notifications to all Monitor Stations or specific users. You can prevent 

these dialog boxes from appearing in your Monitor Station by checking the applicable boxes. 

Flash Red on Motion: You can select this option to highlight the camera toolbar in red to indicate that 

motion has been detected on a camera. This is useful when viewing many cameras at once as shown in 

the figure below. 

Note 
There is no way to retrieve the messages you would have 
received once they are blocked.  
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Use Maintenance view: You can select this option to change the Contact Information tab in Camera 

Properties to Maintenance tab properties. See Maintenance tab for more information on the difference 

between the two tabs. 
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Audio tab 

 

 

Audio notification on motion: You can select this option to give the user the ability to specify if there 

will be audio notification when motion is detected on a camera. You have the option of no sound, 

default system beep or you can load your own notification sound by browsing to a .WAV file. 

Audio notification from tasks and alarms: You can create rules that specify that an audio notification 

will be generated based on a predetermined set of events. You have the option of no sound, default 

system beep or you can load your own custom notification sound by browsing to a .WAV file. 
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Startup tab 

 

Starting Layout: The Monitor Station main dashboard display is set by what is selected here. If you want 

to display a specific camera choose the first camera in layout options and choose 1 Camera Layout from 

the drop-down menu. You can display a specific customized layout by selecting Custom layout and the 

correct server and layout option from the drop-down menu. 

Hide archive tree on startup: Selecting this option hides the left navigation tree. 

Launch facility map on startup: You can select a specific facility map on startup. Check this option and 

select the desired Facility Map from the drop-down menu. When you launch Monitor Station a separate 

pop-up window will display the selected Facility Map. 

Auto upgrade: Select this option to have the local Monitor Station compare its version to all the servers 

that are connected to it at the next startup. If a later version is found on a server Monitor Station will be 

prompted to upgrade, as shown in the figure below. 
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Click Upgrade to upgrade the software on the Monitor Station. Monitor Station will close and the 

installation will appear on the screen. Start Monitor Station and navigate to Help, then About Video 

Insight to confirm the upgrade was successful. 

Start in full screen mode: Select this option to have Monitor Station display in full screen the next time 

it is started. 

Verify Active Directory login: Select this option to have authentication of user credentials in Active 

Directory occur in real-time. 

Enable Auto Login: To bypass the login dialog box, enter the user name and password. See Login for 

more information on login.  

Administration>Setup and Configuration 

You can use Setup and Configuration to change many aspects of the video surveillance setup, including 

changing server properties, user management and application integration with Health Monitor and Live 

View Monitor. Administrator-level access is required to change most of the options. 
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Click the up and down arrow buttons to change the server display order in the left navigation tree. 

Click License ǘƻ ǾƛŜǿ ǘƘŜ ƴǳƳōŜǊ ƻŦ ŜŀŎƘ ǎŜǊǾŜǊΩǎ ŀǾŀilable licenses. Clicking License displays the total 

number of cameras licensed, the total used and the total available, as shown in the figure below. 

 

  

Unknown will 

appear when 

server is not 

connected 
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Setup and Configuration Left Navigation Tree 

 

The left navigation tree displays a status color for each server: 

 = Server is connected and settings may be modified. 

 = Server is not connected due to a login error. It will continue to record video to the specified 

location; however, modifications to settings using MS or IPSM are not allowed. 

 = Server is not connected, possible due to a stopped service or a problem with the connection 

properties; confirm the IP address and port. 

 

{ŜƭŜŎǘƛƴƎ ŀ ǎŜǊǾŜǊ ŦǊƻƳ ǘƘŜ ƭŜŦǘ ƴŀǾƛƎŀǘƛƻƴ ǘǊŜŜ ŘƛǎǇƭŀȅǎ ǘƘŜ ǎŜǊǾŜǊΩǎ ǇǊƻǇŜǊǘƛŜǎΦ !ŘƳƛƴƛǎǘǊŀǘƻǊ ǊƛƎƘǘǎ ŀǊŜ 

required to modify them. See IP Server customization for more information on each field and tab. 

Clicking on a connected server allows quick access to the properties of attached cameras. 
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See Modifying camera details, for more information on camera properties. 

Setup and Configuration Tools Node 

 

See Health Monitor for more information on Health Monitor. You can add any installed Health Monitor 

by entering its IP address and port. Click Connect to test the connection parameters as shown in the 

figure below. 
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Click Add to add the Health Monitor without testing the connection. 

You can view the status of a listed Health Monitor by highlighting it. 

 

Facility Maps 

Camera names may not be descriptive enough to identify a camera. You can use Facility Maps to upload 

floor plans of your buildings and place cameras on the plans to represent their location. This feature 

supports multiple layers of maps that can link to one another and supports cameras on each map. 

Layouts can also be placed on Facility Maps. Once Facility Maps are set up, you can use Monitor Station 

to view all your cameras by Facility Map views instead of the server and camera tree view. 

Adding a Map 

To add a facility map: 

1. Click Facility Map. 
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2. Select the server to add a map. 

3. Click New Map. 

 

4. Enter the map name. 

5. Browse to the location of the map image. JPG- or JPEG-formatted images work best. 

6. Keep the original map size or select a new size for it, keeping in mind the average monitor 

resolution that will be used to view the map in Monitor Station. 

7. Click OK. 
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Note 
Double-click an existing item to remove it from the map.  

 

8. Drag and drop available items from the left pane on to the map and align them with their view. 

Items such as cameras, layouts, doors (doors are access points used for Access Control integrations) and 

other facility maps may be overlaid on the newly created Facility Map. 

9. Verify camera placement by checking the box for View live cameras to view live images from the 

camera. 
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10. Click Recent History to view the last 30 seconds of recorded video. 

 

11. When all items have been positioned on the map, click OK. 
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Deleting a Map 

To delete a facility map: 

1. Click Facility Map. 

 

2. Select the server that has the map to delete. 

3. Select the map to delete from the Facility Maps list. 

4. Click Delete. 

 

5. Click Yes to confirm. 

6. Click Apply and then OK. 

Modifying a Map 

To modify a facility map: 

1. Click Facility Map. 
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2. Select the server with the map to modify. 

3. Select the map to modify from the Facility Maps list. 

4. Click Modify. 

5. Make changes as needed. 

6. Click OK. 

Renaming a Map 

To rename a facility map: 

1. Click Facility Map. 

2. Select the server with the map to rename. 

3. Select the map to rename from the Facility Maps list. 

4. Click Rename. 

 

5. Enter the new map name. 

6. Click OK. 
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Layouts 

You can create custom layouts using cameras from multiple servers. When you add a custom layout to a 
server it is available to all Monitor Station users that have the necessary rights. 

Adding Layouts 

To add a layout: 

1. Select Layouts. 

 

2. Click Add. 

 






























































































































































































































































































































